Graph, analyze, and compare data with this easy-to-use tool!
Credits

Publisher
Richard Abrams

Editor-in-Chief
David A. Dockterman, Ed.D.

Thanks to the team at Tom Snyder Productions:

Copy of License
This document and the software described herein may not, in whole or in part, be copied, photocopied, reproduced, translated, or reduced to any electronic medium or machine-readable form other than that which has been specified herein without prior written consent from Tom Snyder Productions, Inc.

Copy of License
All rights reserved.

Copy of License
© 2001 Tom Snyder Productions, Inc.

Copy of License
Graph Master is a trademark of Tom Snyder Productions, Inc.

Copy of License
Tom Snyder Productions is a registered trademark of Tom Snyder Productions, Inc.

Copy of License
Tom Snyder Productions is a registered trademark of United States Census Bureau.

Copy of License
Microsoft Corporation.

Copy of License
Apple Computer, Inc.

Copy of License
QuickTime and the QuickTime logo are trademarks of Apple Computer, Inc. used under license.

Copy of License
This document and the software described in it may not, in whole or in part, be copied, photocopied, reproduced, translated, or reduced to any electronic medium or machine-readable form other than that which has been specified herein without prior written consent from Tom Snyder Productions, Inc.

Copy of License
For more information about Tom Snyder Productions or for a free catalog, please call us at 1-800-342-0236 or visit us on the Web at www.tomsnyder.com

Executive Producer
Jessica Adler

Designers
Jessica Adler; Eytan Bernet

Software Engineering
Project Management: Eric VanHelene (Vanteon)
Programming: Eytan Bernet, Steve Athanas (Vanteon), Dean Brown (Vanteon)
Programming Support: Eric Hilfer, Sean Nolan
Additional Support (Vanteon): Joshua Bouk, Chuck Dubois, Kelly Forth, Vincent Frisina, Mike Houle, Ann Lafford, Chris Meaker, Dan Palma, Joel Reiser, Aaron Sher, John Szucs

Help System
Tina Moran

Software Quality Assurance
Mark Lynch, Kevin Kennedy-Spaim, Zlatka Fitneva

Art & Design
Software Interface & Design: David Grotrian, Liz Hurley
Print Design & Production: Tina Bourgeois
Cover Illustration: Lauren Harman

Editorial
Teacher’s Guide: Jessica Adler; Tina Moran
Proofreader: Pauline Chin
Interns: Vinh Trinh, Kimberly Macey

Content Review
Joan Weinstein, Grace Kelemanik, Sydney Foster; E. Samuel Palmer

Data Sets
The following organizations generously provided data for use with Graph Master:

Special thanks to the following educators:
Rosalie Allen, Glenn Angell, Mr. Bader; Vincent Baldari, Kathleen Barry, Amy Bebell, Rachel Belviso, Charles Bender; Debbie Bresnick, Lynne Buchhalter; Brenda Bullock, Joanne Calman, Domenic Campagnone, Bob Carpenter, Meagan Carr; Dan Cedrone, Maria Cirmia, Laurie Cleveland, Coleen Collette, Tom Commeret, Diane Cooper, Patrick Cunningham, Linda Curran, Christine Dardia, Mary Deppe, Michele DiGirolamo, Colleen Donahue, Joyce Dziendzic, Merideth Ekwall, Clenna Emery, Maura Erwin, Mark Ferrera, Sarah Fiaram, Paula Fiorillo, Elsa Francescone, Alyson Gaylord-Loy, David Gorman, David Guarnieri, Mark Gura, Gerald Haber; Sondra Hamilton, Joel Heffner; Susan Hirsh, Sara Horton, Erica Ilyn, Judi Mathis Johnson, Mae Kelly, Monica King, Amy Kuhn, Margaret LeBlanc, Debi Levine, Joan Leyland, Lise Linthicum, Crystal Magnant, Faye Manyak, Sandy Martinez, Olivia Mathews, Kay McGarry, Anna Mendez, Mary Anne Michon, Pam Miller; Dan Monahan, Deborah Montagna, Pamela Moore, Suzanne Morin, Peg Mullen, Philomena Mullin, Anne Oates, Jack O’Keefe, Frederick Park, Rebecca Perry, Barbara Peskin, Renee Phillips, Tom Plati, Maggie Prezzano, Deborah Reidy, Kathy Rielly, Raylene Roberts, Janet Rogers, Robert Rossetti, Erik Ruhmann, Barbara Scotto, Michelle Scribner-MacLean, Maureen Severo, Gary Shrager; Mindy, Sick, Mary K. Smith, Mary St. Onge, Katie Sullivan, Bob Thomas, Norman Townsend, Margot Vine, Laurette Viteritti, Charles Vogel, John Ward Jr., Jean Warden, Deborah White, Chris Willems, Molly Wolverton, Deanna Wong
Contents

Getting Started
What Is Graph Master? .......................................................................................................................... 1
What You Get & What You Need........................................................................................................... 2
A Quick Feature Snapshot ..................................................................................................................... 3
Meeting State & NCTM Standards ...................................................................................................... 7

Using Graph Master
Installation...................................................................................................................................................... 9
WalkThrough .............................................................................................................................................. 11
Features & Functions ............................................................................................................................. 29
Technical Support & Troubleshooting.................................................................................................. 49
Nine Graph Types .................................................................................................................................... 51

Classroom Activities ............................................................................................................................ 71

Math Curriculum Matrix ...................................................................................................................... 88

Index ........................................................................................................................................................ 89
What Is Graph Master?

*Graph Master* is a powerful, yet easy-to-use data analysis tool for grades 4-8. The program allows you to meet state and NCTM standards as your students collect, graph, analyze, and present data.

**Collect Data**

Students can collect and enter their own data (up to 16 columns and 512 rows) or they can import data from tables, spreadsheet programs, or the Internet. In addition, *Graph Master* comes with ten sample data sets on topics ranging from immigration to roller coasters!

**Create Graphs**

*Graph Master* lets students create nine types of graphs: Bar graphs, pictographs, circle graphs, line graphs, scatterplots, frequency charts, histograms, line plots, and box plots. The program doesn't just make graphs; it helps students understand and interpret them. As students create a graph, they must make decisions about variables, graph type, and scale. The built-in glossary helps students understand how to use and interpret each of the nine graph types.

**Analyze Graphs**

*Graph Master*’s comparison feature makes it easy for students to compare different representations of the same data (different graph types, different scales), or to view related data sets side by side. Students can also display statistics (mean, median, mode, and range), filter data in lots of different ways, and write observations and conclusions in an on-screen notebook. In the process, students learn to use graphs to investigate and answer questions, such as: “How tall are the students in our class?” or “How have patterns of immigration changed over the past 50 years?”

**Print & Present**

Once students have finished analyzing their data, *Graph Master* makes it easy for them to present their results. Students can print graphs in a variety of formats. They can also save or copy graph images for use in written reports, slide shows, or Web sites.
What You Get & What You Need

What You Get

• Hybrid Macintosh/Windows CD-ROM
• This Teacher’s Guide

What You Need

<table>
<thead>
<tr>
<th>Computer</th>
<th>System</th>
<th>RAM</th>
<th>Monitor</th>
<th>Hard Disk</th>
<th>CD-ROM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power PC Macintosh or better</td>
<td>8.1 or later</td>
<td>32 megs</td>
<td>256-colors; 800 x 600 monitor resolution or higher</td>
<td>10 megabytes of free disk space</td>
<td>Double-speed or higher</td>
</tr>
<tr>
<td>100 MHz or higher</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IBM-compatible Pentium or higher</td>
<td>Windows 95 or higher</td>
<td>64 megs</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>100 MHz or higher</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Data Rights

Graph Master includes ten sample data sets for students to graph and analyze. You are free to use this data, and related graphs, for personal, classroom, and non-commercial uses only. Graph Master data sets are copyrighted materials, and therefore may not be reproduced in books, commercial software, or commercial Internet sites, or broadcast on television.

When you print or export data or graphs for use in school-related or personal (non-commercial) publications or Internet sites, please include the appropriate copyright information. (This information appears in the notebook for each data set file, and also on pages 73–82 of this Teacher’s Guide.)

Thank you!
A Quick Feature Snapshot

Here’s a quick snapshot of just some of the features included in Graph Master. This powerful data analysis tool makes it easy for you and your students to collect, graph, analyze, and present data.

For a step-by-step introduction to using Graph Master, please see the WalkThrough (pages 11–27). For a more comprehensive guide to program features, please see Features & Functions (pages 29–48).

Collect Data

In Graph Master, all data is collected and entered in the data table. You can type data into the data table yourself or use data from tables, spreadsheet programs such as Excel, or files downloaded from the Internet.

<table>
<thead>
<tr>
<th>Name</th>
<th>Gender</th>
<th>Eye Color</th>
<th>Height</th>
</tr>
</thead>
<tbody>
<tr>
<td>David</td>
<td>male</td>
<td>brown</td>
<td>69</td>
</tr>
<tr>
<td>Victoria</td>
<td>female</td>
<td>grey</td>
<td>58</td>
</tr>
<tr>
<td>Tony</td>
<td>male</td>
<td>brown</td>
<td>62</td>
</tr>
<tr>
<td>Judy</td>
<td>female</td>
<td>brown</td>
<td>54</td>
</tr>
<tr>
<td>Alex</td>
<td>female</td>
<td>brown</td>
<td>56</td>
</tr>
<tr>
<td>Karen</td>
<td>female</td>
<td>hazel</td>
<td>60</td>
</tr>
<tr>
<td>Emil</td>
<td>male</td>
<td>brown</td>
<td>65</td>
</tr>
<tr>
<td>Tina</td>
<td>female</td>
<td>blue</td>
<td>50</td>
</tr>
<tr>
<td>Josh</td>
<td>male</td>
<td>green</td>
<td>57</td>
</tr>
<tr>
<td>George</td>
<td>male</td>
<td>brown</td>
<td>50</td>
</tr>
<tr>
<td>Sarah</td>
<td>female</td>
<td>blue</td>
<td>50</td>
</tr>
<tr>
<td>Rosalie</td>
<td>female</td>
<td>brown</td>
<td>54</td>
</tr>
<tr>
<td>Ricardo</td>
<td>male</td>
<td>brown</td>
<td>59</td>
</tr>
<tr>
<td>Ita</td>
<td>male</td>
<td>hazel</td>
<td>72</td>
</tr>
<tr>
<td>Diane</td>
<td>female</td>
<td>blue</td>
<td>60</td>
</tr>
<tr>
<td>Amanda</td>
<td>female</td>
<td>blue</td>
<td>58</td>
</tr>
<tr>
<td>Matti</td>
<td>male</td>
<td>brown</td>
<td>57</td>
</tr>
<tr>
<td>Aaron</td>
<td>male</td>
<td>green</td>
<td>58</td>
</tr>
<tr>
<td>Dana</td>
<td>female</td>
<td>brown</td>
<td>56</td>
</tr>
<tr>
<td>Jon</td>
<td>male</td>
<td>brown</td>
<td>62</td>
</tr>
<tr>
<td>Mary</td>
<td>female</td>
<td>blue</td>
<td>81</td>
</tr>
</tbody>
</table>

Once your data is entered, you can sort your data alphabetically or numerically, change number format, show column totals for columns containing numeric data, and define a column by a formula. You can tally a column of data and create graphs from your data.
Create Graphs

*Graph Master* lets you create nine types of graphs. (To learn more about each graph type, please see pages 51–70.)

- Bar graphs (and double bar graphs)
- Pictographs
- Circle graphs
- Line graphs (and double line graphs)
- Scatterplots
- Frequency charts
- Histograms
- Line plots
- Box plots

Creating a graph is easy! The program takes you through several steps:

1. Choose the variables you want to graph.
2. Choose an appropriate graph type.
3. Choose an independent variable.
4. Set the scale.

When the final step is complete, your graph appears on screen! From there, it’s easy to add a title and make changes to axis labels or scale:
Analyze Graphs

*Graph Master* includes a variety of features designed to help students understand, analyze, and interpret graphs. These include the ability to:

- **Compare** multiple graphs or a graph and a data table side by side.

These graphs display the same data, but use different graph scales. The ability to represent the same data in different ways can lead to great critical-thinking and cooperative-learning activities.

- **Write about graphs** in an on-screen notebook.
- **Show statistics** for graphs containing numerical data. *Graph Master* allows you to display the mean, median, mode, and range. Statistics can be displayed both as numbers and as symbols on a graph.
- **Filter** the data displayed in your graphs.
  *Example:* Your class has just collected data on students’ age, height, and gender, and created a graph showing the distribution of heights. Using this powerful feature, you can filter the data so that the graph displays only the heights of male students, or only the heights of female students.
- **Mark outliers** on box plots and **show a line of best fit** on scatterplots.
Print & Present

With Graph Master, it’s easy to present your results! You can print data tables, graphs, and notebook text. You and your students can also publish graphs or data on the Internet, or incorporate them into written reports, worksheets, slide shows, or portfolio assignments. You can:

- **Print graphs** in a variety of formats including:
  - up to four graphs on a single page
  - in black and white or color
  - regular size or large size (across four sheets of paper)
  - notebook text on its own page, or on the same page as your graphs

- **Copy and paste graphs** into your favorite paint, word processing, or desktop publishing programs.

- **Save graphs as PICT, JPEG, or BMP files.**

- **Save data as tab-delimited text files** which can be opened in spreadsheet programs such as *Excel*.

*Graph Master* also includes:

- Teacher preferences that allow you to limit the types of graphs available to students, and modify the graph-creation process.

- An extensive Help system, including a glossary of data analysis terms and tips on using and interpreting the nine graph types.
Meeting State & NCTM Standards

*Graph Master* is designed to teach data analysis skills as students collect and organize data, create graphs, analyze graphs, and present their results. The learning objectives of the program correlate to the NCTM Standards, as outlined below. For correlations to state standards, visit our Web site at: www.tomsnyder.com/products/standards.

<table>
<thead>
<tr>
<th>NCTM Standards</th>
<th>Graph Master</th>
</tr>
</thead>
<tbody>
<tr>
<td>Students should be able to…</td>
<td>Students can…</td>
</tr>
<tr>
<td>Formulate questions that can be</td>
<td>• Collect and enter data in <em>Graph Master’s</em> data table.</td>
</tr>
<tr>
<td>addressed with data and collect,</td>
<td>• Represent data using nine types of tables and graphs, including:</td>
</tr>
<tr>
<td>organize, and display relevant data to</td>
<td></td>
</tr>
<tr>
<td>answer them.</td>
<td>- Bar graph</td>
</tr>
<tr>
<td>(Data Analysis &amp; Probability Standard)</td>
<td>- Frequency chart</td>
</tr>
<tr>
<td></td>
<td>- Pictograph</td>
</tr>
<tr>
<td></td>
<td>- Histogram</td>
</tr>
<tr>
<td></td>
<td>- Circle graph</td>
</tr>
<tr>
<td></td>
<td>- Line plot</td>
</tr>
<tr>
<td></td>
<td>- Line graph</td>
</tr>
<tr>
<td></td>
<td>- Box plot</td>
</tr>
<tr>
<td></td>
<td>- Scatterplot</td>
</tr>
<tr>
<td>Make decisions about appropriate</td>
<td>• Make decisions about appropriate variables, scale, and graph type.</td>
</tr>
<tr>
<td>variables, scale, and graph type.</td>
<td>• Choose different graph types, depending on whether data is categorical or</td>
</tr>
<tr>
<td></td>
<td>Choose different graph types, depending on whether data is categorical or</td>
</tr>
<tr>
<td></td>
<td>numerical.</td>
</tr>
<tr>
<td></td>
<td>• Use the compare feature to view different representations of the same</td>
</tr>
<tr>
<td></td>
<td>data (different graph types, different scale) side by side.</td>
</tr>
<tr>
<td></td>
<td>• Use the compare feature to view graphs from two related data sets side by</td>
</tr>
<tr>
<td></td>
<td>side.</td>
</tr>
<tr>
<td>NCTM Standards</td>
<td>Graph Master</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Students should be able to…</td>
<td>Students can…</td>
</tr>
<tr>
<td>Select and use appropriate statistical methods to analyze data.</td>
<td>• Display and interpret measures of center (mean, median, and mode).</td>
</tr>
<tr>
<td></td>
<td>• Display and interpret range of data.</td>
</tr>
<tr>
<td></td>
<td>• Mark outliers in a data set, and explore how outliers affect the mean.</td>
</tr>
<tr>
<td></td>
<td>• Display a line of best fit on a scatterplot.</td>
</tr>
<tr>
<td></td>
<td>• Use the filter feature to analyze and compare subsets of data.</td>
</tr>
<tr>
<td>Develop and evaluate inferences and predictions that are based on data.</td>
<td>• Use the enclosed data files and activities to explore real-world questions, or… come up with their own!</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Organize and consolidate their mathematical thinking through communication.</td>
<td>• Write about data and graphs in the on-screen notebook.</td>
</tr>
<tr>
<td></td>
<td>• Print data tables, graphs, and notebook text for use in presentations and reports.</td>
</tr>
<tr>
<td>Understand patterns, relations, and functions.</td>
<td>• Create and interpret line graphs of linear and non-linear functions.</td>
</tr>
<tr>
<td></td>
<td>• Use line graphs to explore linear change.</td>
</tr>
<tr>
<td></td>
<td>(Data Analysis &amp; Probability Standard)</td>
</tr>
<tr>
<td></td>
<td>(Data Analysis &amp; Probability Standard)</td>
</tr>
<tr>
<td></td>
<td>(Communication Standard)</td>
</tr>
<tr>
<td></td>
<td>(Algebra Standard)</td>
</tr>
</tbody>
</table>
Installation

Macintosh
1. Insert the CD-ROM into the CD-ROM drive.
2. Double-click the Graph Master Installer.
3. Follow the on-screen instructions to install Graph Master.
4. To launch the application, double-click the Graph Master icon on your computer’s hard drive.

Windows 95 or Higher
1. Insert the CD-ROM into the CD-ROM drive.
2. From the Start menu, choose Run.
3. Type D:\SETUP (where D is your CD-ROM drive) and click OK.
4. Follow the on-screen instructions to install Graph Master.
5. To launch the application, go to the Start menu and choose Graph Master from the Programs folder.

Network Installation
Graph Master can be installed to your network or run off a network CD tower. Follow the instructions below. Please see the Installation Instructions file on the CD for more information.

Installing to a Network Server

Macintosh
Simply drag the Graph Master folder to your network volume.

If you wish to have searchable Help: At each workstation, navigate to the Graph Master folder on your network volume, double-click the Help Installer, and follow the on-screen directions.

Windows 95 or Higher
Simply drag the Graph Master folder from the CD-ROM to your network volume.

At each workstation, navigate to where you have just installed Graph Master on the network, and run the SETUP.EXE application. This will install a Graph Master shortcut in the workstation’s Start menu.
Installing to a CD Tower

**Macintosh**
Insert the Graph Master CD-ROM in the network CD tower.

*If you wish to have searchable Help:* At each workstation, navigate to the Graph Master CD-ROM, double-click the Help Installer, and follow the on-screen directions.

**Windows 95 or Higher**
At each workstation, navigate to the Graph Master CD-ROM, and run the SETUP. EXE application. This will install a Graph Master shortcut in the workstation’s Start menu.
WalkThrough

This WalkThrough steps you through the basics of analyzing data with Graph Master. You’ll learn how to collect and enter data, create graphs, analyze your graphs in a variety of ways and print and present your results.

For a quick overview of program features, see A Quick Feature Snapshot (pages 3– 6). For comprehensive descriptions of each feature, see Features & Functions (pages 29– 48).

Get Started

1. Install the software. (See page 9 for instructions.)
2. Double-click the Graph Master icon on your hard drive. The opening screen will appear.

3. Click New Data Set. A new, empty data table will appear. This is where you will enter your data.
Collect Data

We’ll begin by exploring the following question:

*What is the proportion of colors in a snack-size bag of your favorite multicolored candy?*

Let’s imagine your students have investigated three bags of candy and come up with the results shown below:

Let’s enter this data in the data table. Notice that the data table is divided into rows and columns. Each column holds data for a different variable.

![Data Table]

*Use column labels to describe the data contained in each column.*

[TIP]

When entering data, click **Tab** to move one cell to the right. Click **Return** to move one cell down. You can also use the arrow keys to navigate up, down, left, or right.

*Enter your data in the cells below.*
1. First, let’s enter column labels. When you make a graph, these column labels will become your axis labels, so it’s important to be descriptive! Since we’re investigating the color of candies in each of the three bags, let’s label the columns **Color**, **Number in Bag 1**, **Number in Bag 2**, and **Number in Bag 3**.

   - Click the column label for column A (“Variable A” by default).
   - Type “Color.”
   - Now, continue adding labels to columns B, C, and D.

2. Next, let’s add the data in the columns below. Just click and type!

3. Now go to the **Data** menu and choose **Show Column Totals**. The total number of candies in each bag will appear at the bottom of the table.

![Data Table with Column Totals](image)

Data Table with Column Totals

The Greek letter Sigma means sum or total. This row shows the totals for each column containing number data.

**Save**

Before continuing, let’s save our work.

1. Choose **Save Data Set As...** from the File menu. You can also press **⌘-S** (Macintosh) or **Control-S** (Windows).
2. Give your data set file a name (for example, “Candy”) and save it onto your hard drive.
Create Graphs

Now that you’ve entered your data, you’re ready to make a graph! When you create a graph, Graph Master guides you through a series of screens on which you’ll make choices about variables, graph type, and scale. (This series of screens can be modified using the Teacher Preferences settings. See page 36.)

Let’s start by making a graph of the candy colors in bag 1.

Choose Variables

1. Click the Graph button on the toolbar. (The toolbar runs along the left side of the screen.) The Choose Variables dialog box appears.

2. Click the checkboxes for the variables you would like to graph. Since we want our graph to display the different candy colors along the x-axis, and the number of candies in bag 1 along the y-axis, we’ll click Color and Number in Bag 1. Notice that the corresponding columns highlight when they are selected.
Choose Graph Type
1. When you have made your selection, click OK. The Choose Graph Type dialog box appears. This dialog box shows you the nine types of graphs available in Graph Master.

2. Experiment by clicking buttons for different graph types. Notice that a description of each graph type appears at the bottom of the dialog. This allows students to determine which is the most appropriate type of graph for their data. Depending on the data you have selected, some graph types will be unavailable. To learn why a given graph is unavailable, simply move your cursor over that graph type, and an explanation will appear below.

3. For now, let’s try a bar graph. Click Bar Graph, then click OK.

Set the Scale
1. Next, let’s set a scale for our bar graph. The numbers in red show the range of the data displayed on the y-axis (in this case, from 4 to 23). Use this information to choose an appropriate minimum, maximum, and step size for your graph.

   The maximum is the highest value in your scale.

   The step size is the difference between consecutive values.

   The minimum is the lowest value in your scale.

Then click OK, and your graph will appear!
Add a Title
Click Title at the top of your bar graph and enter a title for your graph, such as “Candy Colors in Bag 1.”

Change Axis Labels
Click the y-axis label (“Number in Bag 1”) and change the label to “Number of Candies.”

Change Bar Colors
1. Go to the Graphs menu and choose Change Colors. Let’s change the colors of the bars so that they match the colors represented in the graph.

2. The first color in our list is brown. Click a brown square in the color palette. Notice that the fill color (at left) changes to brown.

3. Now click the label Brown, below. Notice that the color associated with the label is now brown. Continue changing the rest of the colors so they match their labels. Then click OK.
**Change the Scale**

Click any number along the y-axis scale. The Set Scale dialog box appears again. Change the scale maximum to 30.

**Change Graph Type**

1. Move your cursor to the Graph Type buttons at the top of your graph window. As you move your cursor slowly over each button, a tool tip names each graph type. You can use these buttons to change how your data is displayed. Click the circle graph button and watch your graph change to a circle graph.

2. By default, circle graphs are labeled with fractions. Let’s change the labels to percentages. Click one of the labels on the circle graph. The following dialog appears:

3. Click the button for percent. Then click **OK**.
Analyze Graphs

*Graph Master* makes it easy to analyze your data. For example, you can create multiple graphs from your data set, and view them side by side. Let’s make another graph from the data, and see how it compares to the first graph!

**Navigate between Windows**

1. Click **Data Table** on the toolbar. This lets you return quickly to the data table. You can also use the Window List and Last Window buttons to navigate between graphs and tables:
   - **Window List** — displays a list of windows, including the data table, graphs, and notebook. Just select the item you wish to display.
   - **Last Window** — toggles back and forth between the active window and the window that was previously active.

2. Select the columns of data labeled Color and Number in Bag 2. In order to select non-adjacent columns, hold down the ⌘ key (Macintosh) or CTRL key (Windows) while clicking the letters at the top of each column. Then click **Graph**, and **OK**.

3. Click **Circle Graph**, then **OK** to make a circle graph of this new data.
4. Change the graph title to “Candy Colors in Bag 2.”
5. Change the circle graph labels to percentages.
6. Change the colors to match the labels.

**Compare Graphs**

1. Click **Compare** on the toolbar. The Compare dialog box appears. Use the pull-down menu on the left to choose the first graph you created (Candy Colors in Bag 1). Use the pull-down menu on the right to choose the second graph (Candy Colors in Bag 2).

2. When you have selected your two graphs to compare, click **OK**. Your two graphs will appear side by side.
Write in the Notebook

1. Click Notebook on the toolbar. Write a few lines describing the similarities and differences between our two graphs.

2. When you are done writing in the notebook, click the close box on the notebook window.

3. Let’s take this opportunity to save our work again by choosing Save Data Set... from the File menu. The data table, graphs, and notebook text will all be saved together as one data set file.

Tip
Use the buttons at the bottom of the notebook to make text larger or smaller.

Tip
Sometimes you may create a graph that you don’t want to save. To delete the active graph, choose Delete Graph from the Graphs menu.
Print & Present

Once you’ve completed your analysis, it’s time to print the results.

1. To print, choose Print... from the File menu. You can also press ⌘P (Macintosh) or Control P (Windows).

2. From the list on the left, select all the items you want to print. The selected items will be displayed in the Preview area on the right. Up to four graphs, and the notebook, can be printed on a single page, however the data table will always print out on its own page.

3. Experiment with the various print options and notice how they change the Preview. When you are satisfied with your choices, click OK.

TIP

If the print preview is more than one page long, use the arrows below the preview to move forward and backward.
Analyze Graphs in More Depth

In the first part of this WalkThrough, we demonstrated the basics of analyzing data with Graph Master. We showed you how to collect and enter data, create graphs, analyze graphs, and print your results. Next, we will explore some more advanced ways to use Graph Master to organize and analyze data. We will begin by investigating a new question: *How tall is the typical student in our class?*

Earlier in this WalkThrough, you entered data into the data table yourself. This time, we’ll take a look at a pre-existing data set file.

1. Choose **Open Data Set** from the File menu.
2. Locate the Data Sets folder and open the file called **WalkThrough**. This file contains data on fifty students, including their gender, age, and height (in inches).

Sort Data

Take a look at the data in the data table. How tall are most of the students in our sample? To get a sense of the range of the data, let’s sort this information by height.

1. Choose **Sort…** from the Data menu. The Sort dialog box appears.

![Sort dialog box]

2. Choose **Height (inches)** from the pull-down menu, since we’d like to sort our data according to height. Then click **OK**.

Shorter students will be listed first; taller students later. After scrolling down through the data table, you can see that the tallest student is 72 inches in height.
Tally Data

Now let's make a graph of the data on students' heights. You'll notice that this data, unlike the data you entered earlier, is untallied. Although we can see individual students' heights, we don't yet know how many students there are of each height (or interval of heights).

If you were making a graph by hand, you would probably begin by tallying this data. The same is true when using Graph Master.

1. Click the **Tally** button on the toolbar. The tally dialog box appears.

2. Choose **Height (inches)** from the pull-down menu, since we wish to tally the data on students' heights.
3. Click **OK**. A dialog box will appear containing the tallied data.

---

**TIP**
You can set Teacher Preferences to skip this dialog (see page 36).

---

Data Table with Tallied Data
Tallied Data
Now let’s go ahead and display this data. We’ll begin by creating a frequency chart.

1. Click the **Graph** button on the Tallied Data dialog box.
2. Click **Chart** on the Graph Choice dialog box. Then click **OK**.
3. Choose the intervals of data that will appear in the frequency chart. Since students in this class range from 55 inches to 72 inches, let’s choose a minimum of 54, an interval size of 2, and a maximum of 74. Then click **OK**.
4. Make sure to add a title to your chart.
5. Change the label of the 2nd column from Frequency to Number of Students.
Now let’s explore another graph.
6. Click the Histogram graph type button (third from right) and watch your chart change to a histogram. A histogram is similar to a bar graph, except each bar represents an interval of numeric data (rather than a category).

![Histogram](image)

Display Statistics
Now that we’ve created a graph of students’ heights, let’s analyze this graph. The **Analyze** menu contains lots of options for exploring data in more depth.

1. Choose **Statistics** from the Analyze menu. A check will appear next to the menu item, and the program will display statistics for your data, including mean, median, mode, and range.

![Statistics](image)

We can see that the mean height for this group of students is 59.54, while the median height is 59. If students want a refresher on these terms, they can look them up in the program’s glossary (see page 48).
You’ll notice that currently, each interval label is centered under the corresponding bar. Histograms can also be labeled a second way, with numbers appearing along the axis in a number line (see pages 61–62). Because the numbers are displayed in a number line, this approach is helpful for viewing statistics.

2. Open the Graphs menu and deselect Center Numbers Under Bars (so that the check mark next to this item disappears). Notice that checkboxes now appear next to the Mean, Median, and Range.

3. Click the checkbox to the left of the word Mean. This displays a graphical symbol (a red triangle) along the x-axis, showing where the mean falls in relation to the data. Take a moment to display the median and range as well.

4. Click the triangle in the upper right of the window. (This is a quick way to show and hide statistics.) Notice that the graphical symbols remain on the screen. To remove them, simply open the statistics again and click the checkboxes once more.
Filter Data

After looking at the class’ mean height, a student in your class might wonder:

*Is average height the same for each gender, or is one group (on average) taller than the other?* We can investigate this question using the filter feature.

1. First, let’s clone our original graph. Click on your histogram (to make that graph active), then choose **Clone Graph** from the Graphs menu. An identical graph appears. You can check that a new graph has been created by:
   - clicking Window List
   - dragging the new window to reveal the original underneath

The original graph and its clone can now be manipulated independently.

2. Click on the cloned graph. We’re going to filter this graph so that it only includes height data for boys.

3. Choose **Filter** from the Analyze menu. The filter dialog appears. This dialog displays a checkbox for all columns which currently contain some data (in this case Student, Gender, Age, and Height).

4. Click the checkbox for Gender, since we want to filter our data by Gender.

5. Next, using the pull-down menus, choose **is** from the first pull-down menu, **M** from the second. This filters the graph to include only rows of data in which the student’s gender is male. Click **OK**. Your graph now displays the heights of boys only.
6. Let’s change our title to communicate this. Click Title and change the graph’s title to “Boys’ Heights.”

TIP
When a graph has been filtered, an * appears in the window’s title bar. This makes it easy to identify filtered graphs.

7. Now let’s do the same for girls. Click the graph you just created, and clone it (choosing Clone Graph from the Graphs menu).
8. Click the cloned graph and choose Filter from the Analyze menu.
9. Click the Gender checkbox. Then using the pull-down menus, set the filter to include rows of data in which gender is female. Then click OK.
10. Change the title of this new graph to “Girls’ Heights.”

11. Now let’s compare our two graphs. Click Compare and choose the two graphs we just made. Click OK.

![Comparison of Filtered Graphs](image)

Take a look at your two graphs. Do you see a difference?

There are lots of other features in Graph Master to experiment with. For a feature-by-feature list, see the Features & Functions reference section (pages 29–48).

**TIP**

For further interesting investigations, see the Heights activity, page 76. In this activity, students compare boys’ and girls’ heights in the 4th, 6th, 8th, and 12th grades.
Features & Functions

This section contains in-depth information on Graph Master’s features and functions including the data table, graphs, toolbar buttons, and menu items. For a quick overview of program features, see A Quick Feature Snapshot (pages 3–6). For a step-by-step guide to entering data, creating and analyzing graphs, see the WalkThrough (pages 11–27).

The Data Table

Every data set file contains a data table, where all data is entered and stored. The data table is organized in rows and columns. Each column contains data for a different variable.

Click a **column letter** to select a column. There are 16 columns.

Click and type to change the **column label**. This label describes the data contained in the column.

Click a **row number** to select a row. There are 512 rows.

Click and type in the **data cells** to enter data.

Cells are identified by their column-row location. This is cell E7.
**Entering data in the data table**

Organize your data in columns. Each column in the data table should contain data for a single variable.

1. Type a label for the data in each column. By default, columns are labeled “Variable A,” “Variable B,” etc. (Later, when you graph your data, these column labels will become your axis labels.)

2. Enter the corresponding data in the column.
   - You may enter either category data (text) or number data. Numbers up to 999,999 are supported. (Note: If any cell within a column contains non-numeric data, the entire column will be considered category data.)
   - You may enter either raw (untallied) data or data that has been tallied.

**Moving around within the data table**

There are two modes for moving around within the data table: Select Mode and Edit Mode.

- When you first click on a new cell, you are in Select Mode.
  In Select Mode, the selected cell is highlighted.

- If you click a second time within a cell, you will enter Edit Mode.
  In Edit Mode, the cursor blinks.

The following keys and menu items help you move around within the data table:

<table>
<thead>
<tr>
<th>Key or Menu Item</th>
<th>Select Mode</th>
<th>Edit Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab</td>
<td>move one cell to the right</td>
<td>move one cell to the right and enter Select Mode</td>
</tr>
<tr>
<td>Return (Macintosh) Enter (Windows)</td>
<td>move one cell down</td>
<td>move one cell down and enter Select Mode</td>
</tr>
<tr>
<td>Left &amp; right arrow keys</td>
<td>move one cell left or right</td>
<td>move one text character to the left or right within a cell</td>
</tr>
<tr>
<td>Up &amp; down arrow keys</td>
<td>move one cell up or down</td>
<td>move to the beginning or end of text within a cell</td>
</tr>
<tr>
<td>Page up</td>
<td>move one screen up</td>
<td>move one screen up and enter Select Mode</td>
</tr>
<tr>
<td>Page down</td>
<td>move one screen down</td>
<td>move one screen down and enter Select Mode</td>
</tr>
<tr>
<td>Home</td>
<td>move to top left cell of data table</td>
<td>no effect</td>
</tr>
<tr>
<td>Select All (in Edit menu)</td>
<td>select all cells in data table</td>
<td>select all text within a cell</td>
</tr>
</tbody>
</table>

For further information on the data table, read about the Data menu on page 38.
Creating a Graph

Once you have entered your data, and are ready to create a graph, click the Graph button on the toolbar (or choose Graph from the Data menu). Graph Master will then guide you through a series of screens on which you make choices about variables, graph type, and scale.

Note: This series of screens can be modified using the Teacher Preferences settings. (See page 36.)

Step 1: Choose Variables

The first screen that appears asks you to choose the variables (columns of data) you wish to graph. Click the checkboxes to choose variables. Choose two variables for standard graphs, three for double bar or double line graphs. (If you can only identify one column of data to graph, you may need to tally your data first. See page 38.)

Hint: You can set Teacher Preferences to skip this dialog (see page 36) and select the columns you want to graph prior to clicking Graph. Select a column by clicking the letters at the top of the desired column. Select non-adjacent columns by holding down CTRL (Windows) or ⌘ (Macintosh) while you select your columns.
Step 2: Choose Graph Type

The next screen asks you to choose the type of graph you want to create. Click a button to select a graph type. A description of the graph type you have selected will appear in the dialog. When you are satisfied with your choice, click OK.

**Hint:** Some graph types will not be available for certain types of data. To see a message explaining why a graph is unavailable, place your cursor over the button for that graph type.

Step 3: Choose Independent Variable

If you have chosen to graph two columns of numerical data, you must identify which variable is the independent variable. (This is the variable that will be displayed on the x-axis.) Choose a variable from the pull-down menu. Then click OK.
Step 4: Set the Scale

Finally, set the scale for your graph. The range of the data is included on this dialog in order to help you choose an appropriate scale. (In the example shown, the data ranges from 5 to 18.) Type a minimum, maximum, and step size for the scale. Then click OK.

Once you have completed these steps, your graph will be displayed. You can change various elements of the graph (such as title, axis labels, and scale) by clicking on them. You can also change other graph features using the Graphs menu (see pages 40–44).

Click any number on the scale to change the scale (minimum, maximum, and step size).

Click the graph type buttons to change how your data is represented. (See page 17.)

Click the title to type title text.

Click the axis labels to type new labels.
The Toolbar

The toolbar provides easy access to many of Graph Master's key features.

**Window List**
Lets you choose a data table, graph, or notebook to display.
(A check mark identifies the active window.)

**Last Window**
Returns to the previously active window.

**Data Table**
Displays the data table.

**Tally**
Lets you choose a column of data to tally. The resulting tally is displayed in a dialog box. (See page 38.)

**Graph**
Lets you create a graph from data in the data table.
(See page 31.)

**Compare**
Lets you choose two graphs or tables to compare. After making your choice, and clicking OK, your two graphs will be displayed side by side.
(See page 45.)

**Notebook**
Opens a notebook where you can describe, analyze, or ask questions about your graphs. Each data set contains one notebook.

**Help**
Displays help — including information on program features, a glossary of data analysis terms, and tips on the currently displayed graph type or dialog box.
The File Menu

New Data Set
Opens a new data set.

Open Data Set...
Lets you open a previously saved data set, or tab-delimited text file.

Close Data Set
Closes the active data set.

Close Window
Closes the active window. (If the window is a graph, you may choose to hide the graph or delete the graph permanently.)

Save Data Set
Lets you save the active data set (including the data table, notebook, and corresponding graphs).

Save Data Set As...
Lets you save a previously saved data set under a new name or location.

Page Setup...
Lets you set page orientation and other specifications for printing.

Print...
Opens the Print dialog box. This dialog box lets you print the data table, notebook, and graphs for one or more data sets. Select the items you want to print from the list on the left. Items will appear on the page (and in the print preview) in the order they are listed.
Teacher Preferences...
Let’s you customize the program to meet the needs of your students. This option is always grayed to restrict student access. To access Teacher Preferences:

- **Macintosh**: Hold down the `⌘` and Option keys and (without letting go) open the File menu and choose Teacher Preferences.
- **Windows**: Hold down the Shift and Control keys and (without letting go) open the File menu and choose Teacher Preferences.

**Note**: If you open the File menu before pressing these keys, Teacher Preferences will remain grayed.

The Teacher Preferences allow you to modify the program in the following ways:

**Graph Types**: Provide students access to all nine graph types, or to a basic set of six (Bar, Pictograph, Circle, Chart, Line, Scatterplot).

**Graph/Tally options**: By default, all three of these options are turned on. Turn them off to minimize the number of steps involved in making a new graph.

- **Confirm variables to graph**: When this option is turned off, the Choose Variables dialog (see page 31) will not appear if appropriate columns have been selected.
- **Display tallied data**: When this option is turned off, the Tallied Data dialog does not appear. (Clicking Tally leads directly to the Choose Graph Type dialog.)
- **Set scale before viewing graph**: When this option is turned off, the user is not required to set the scale when creating a new graph.

**Number Format defaults**: Use these options to change the default format for columns of number data. (**Note**: Changing the defaults will change the default format for new data sets. It will not change the format for columns in existing data sets.)

**Quit (Macintosh) or Exit (Windows)**
Closes the program and prompts you, if necessary, to save changes.
The Edit Menu

These options are standard text-editing functions. With the exception of Undo and Copy Graph, they are available only when a text field is active.

**Undo**
Undoes your last action.

**Cut**
Removes selected text so you can paste it in another location.

**Copy**
Duplicates selected text so you can paste a copy in another location.

**Copy Graph** (Available only when the current window is a graph.)
Copies an image of the selected graph to the clipboard, so that you can paste it into a word processing, paint, or draw program.

**Paste**
Pastes the contents of your clipboard into the selected location.

**Clear**
Erases selected text.

**Select All**
Selects all cells in the data table (in Select Mode). Selects all text within a cell (in Edit Mode). (See page 30.)
The Data Menu

**Graph...**
Lets you create a graph from data in the current data table. (See page 31.)

**Tally...**
Tallies the data in the selected column. If no column is selected, you are prompted to choose a column. Click **Graph** on the Tallied Data dialog box to graph the tallied data. (See page 23.)

---

**Show Column Totals**
Displays a total for all columns with number data. The totals appear in a row at the bottom of the data table.

**Sort...**
Lets you sort the data table by the contents of a single column.
(The data in the column can be sorted in ascending or descending order.) Choose a column to sort by. Then click OK.
Number Format...

Lets you format number data in the selected column (or columns). You may display numbers rounded up to 5 decimal places. You may also choose whether to display numbers with or without commas. (If neither box in this dialog is checked, data will be displayed exactly as entered.)

![Number Format dialog]

Formula

Lets you use a formula to define a selected column in relation to existing data columns. When a column contains a formula, data in the column appears in blue, and cells cannot be edited directly.

The Formula menu provides four different options:

Select **None** if you do not wish to apply a formula to the column. *(None is active by default.)*

Select **Row Total** to display the total of numbers to the left of the selected column. (Text data will be ignored.)

Select **Row Average** to display the average (arithmetic mean) of numbers to the left of the selected column. (Text data will be ignored.)

Select **Other**… to apply your own formula to a column. The Formula dialog box will appear. To set up your formula:

1. Choose a variable from the first pull-down menu, or choose **number**... and then type a constant.
2. Choose an operation from the second pull-down menu.
3. Choose another variable from the third pull-down menu (or choose **number**...). Your formula will appear in the box below.

![Formula dialog]
**Hide Column**
Hides selected columns in the data table. (To select a column, click the letter above the column.)

**Show All Columns**
Shows all columns that were previously hidden.

**Save Data as Text...**
Lets you save the data in the data table as tab-delimited text. The resulting file can be opened in any spreadsheet program.

**The Graphs Menu**
These options allow you to edit graphs. Some of these functions apply to all graph types; others apply only to certain graphs.

**Change Scale...**
Lets you change the scale on a bar graph, line graph, histogram, line plot, box plot, or scatterplot. For each numerical axis, you must choose a minimum value, maximum value (up to 1,000,000), and step size. The range of the data is displayed on screen, so that you can choose an appropriate scale. In the example below, the data for the y-axis ranges from 7 to 17. (See individual graph types, pages 51–70, for more detail.)

![Change Scale](image)

**Change Intervals...**
Lets you change the intervals on a frequency chart with numeric categories. You must choose a minimum value, maximum value (up to 1,000,000), and interval size. The range of the data is displayed on screen so that you can choose an appropriate scale.
Change Pictograph Scale...
Lets you change the scale on a pictograph. You must define how many items each symbol represents. In the example below, each symbol represents 2 houses.
**Change Colors...**
Lets you change the colors of bars (in a bar graph) or circle segments (in a circle graph). To change a color: 1) First select a color from the palette. Your selected color will be displayed in the Fill Color box. 2) Then click a category to assign the selected color to that category.

![Change Colors](image1)

**Change Symbol...**
Lets you change the symbol displayed in a pictograph. Choose from a library of over 100 symbols. (The same symbol is used for all pictograph categories.)

![Change Symbol](image2)
Graph Master lets you import your own graphics to use as symbols. Here’s how:

- Using a paint or draw program, create your own graphic. (The image sizes in Graph Master are 28 x 28. The closer your graphics are to this size, the better they will look.)
- Copy the graphic. It will be saved to your computer’s clipboard.
- Open Graph Master.
- Choose Change Symbol from the Graphs menu.
- Click Paste. Then click OK.
- Your graphic will now appear in your graph.

Note: Icons you make will not be saved in the program, but will be saved in the graphs you create using them.

Show Grid
Lets you turn grid lines on and off for bar graphs, line graphs, scatterplots, and histograms. By default, grid lines are on.

Center Numbers Under Bars
Lets you change how a histogram is labeled. (See pages 65–66.)

Note: This option is only available when the data consists only of integers. Otherwise, histograms are always labeled with numbers at edges of bars.
Change Circle Graph Labels
This option lets you label circle graphs seven different ways: with fractions, simplified fractions, count, decimals, percentages, angles (measured in degrees), or with no label at all.

Note: By default, circle graph segments are labeled with fractions in which the numerator is the frequency of data within a specific category and the denominator is the total number of pieces of data.

Label Orientation
Lets you change the orientation of x-axis labels to either horizontal or vertical. Horizontal labels are the default. Vertical labels can be extremely useful if a graph appears crowded.

Save Graph As
Lets you save graphs in PICT or JPEG format (for Macintosh users), or BMP format (for Windows users).

Clone Graph
Lets you create a new graph window identical to the active graph. A graph window and its clone are independent of one another; features such as graph type, color, scale, and labels can be changed independently.

Hide Graph
Use this option to hide the active graph window. To access the hidden graph, use the Window List button on the toolbar.

Delete Graph
Use this option to delete an unwanted graph.
The Analyze Menu

These options allow you to compare, analyze, or write about your graphs. Some of these functions apply to all graph types; others apply only to certain graphs.

Compare...
Lets you choose two graphs or tables to compare. Use the pull-down menus to choose from a list of all available graphs and data tables. When you are finished making your choice, click OK. Your two graphs will be displayed side by side.

If you choose the same graph from both pull-down menus, the graph you chose will be cloned (see page 44), and the original and clone will appear side by side.

Filter...
This option allows you to filter the data values displayed in a graph. (See pages 25–27.) Selecting Filter opens a dialog box containing a series of pull-down menus, one for each column of data. Use these menus to identify which data you wish to include in your graph. The graph below is filtered to include only the data from rows in which Gender is male and Age is greater than 12 (i.e., data for males older than 12). When a graph has been filtered, an * appears in the window’s title bar.

1) Click the checkboxes to select the variables you want to filter by.
2) Then use the pull-down menus to define the filters.
Statistics
Displays statistics on box plots, histograms, line plots, scatterplots, and frequency charts containing numerical data.

All statistics are displayed in numerical format. In addition, some statistics can be viewed as graphical representations on the corresponding graph. To view a statistic as a graphical representation, simply click the checkbox located next to the statistic. If no checkbox appears, a graphical view for the statistic is unavailable.
**Line of Best Fit**
Lets you display the line of best fit for scatterplots.

**Mark Outliers**
Identifies outliers on box plots. The outliers are represented by asterisks (*).
The Help Menu

The Help Menu provides easy access to a variety of help features.

**Help**
Displays helpful tips on the currently displayed graph type or data table. For example, if a bar graph is displayed, clicking Help will provide tips on interpreting and editing bar graphs.

**Contents**
Displays a list of help contents.

**Index**
Displays an alphabetized list of program features.

**Glossary**
Displays an alphabetized list of data analysis and graphing terms.

**Show Tool Tips**
Turns tool tips on or off. (By default, tool tips are on.)

**Launch Graph Master Web site**
Opens your browser to Graph Master’s Web site.
Technical Support & Troubleshooting

Technical Support
If, after reading through the Features & Functions section and following the troubleshooting tips below, you are still having trouble, please call our Technical Support team at 1-800-342-0236.

When you call, please have the following information available:

• Software title and version number: These can be found on the CD-ROM and in the About Graph Master dialog box (under the Apple menu if you’re using Macintosh; under the Help menu if you’re using Windows)
• Your computer platform (e.g., Windows 95, 98, or 2000; Macintosh OS 8.1, 9.0)
• Your computer model (e.g., Power Macintosh 6100; Compaq Prolinea)
• Your computer’s memory (e.g., 32 megabytes of RAM)
• Your computer’s processor and speed (e.g., Pentium processor running at 200 MHz)

If possible, please have the software running on a computer close to the telephone when you call.

Our technical support staff is available Monday through Friday, 8 a.m. to 4 p.m. EST. You can also e-mail us at tech@tomsnyder.com.

Troubleshooting
This troubleshooting guide contains answers to frequently asked questions. For the latest technical updates, check the ReadMe file (installed in the Graph Master application folder).

My system is running very slowly.
If your system begins to slow down, take the following steps:

• Close down all applications other than Graph Master.
• If you have multiple data sets open, close some data sets.
  (To close a data set, click the close box on the corresponding data table.)
• If you have many graphs open, delete any unnecessary graphs.
  (To delete a graph, select the graph from Window List. Then choose Delete Graph from the Graphs menu.)
• If you have multiple columns defined by formulas, remove the formulas (going from left to right). The data will remain in the cells, but will not update automatically when cells are changed.
I am unable to select the graph type that I want to create from the Choose Graph Type dialog.

Many of the graph types in Graph Master require either one or more columns of numerical data. If you are having difficulty making a graph, check the requirements for that graph type (see Nine Graph Types, pages 51–70) and make sure the columns of data you have selected meet the appropriate criteria.

Check that all columns of numbers are being treated by the program as number data and not as category data. (Number data will appear right-justified, category data left-justified.) Number data will be treated as category data if:

• any of the cells contain invalid numbers (i.e., numbers that contain incorrectly placed commas, text characters, or symbols such as %, $, or /)
• any of the numbers are 1,000,000 or over (Graph Master only supports numbers up to 999,999.) If you are dealing with data in the millions, change your units to thousands. (For example, 1,999,564 people becomes 1,999.564 thousands of people.)

I can't locate the Data Sets folder.

Many of the activities described in this Teacher's Guide (pages 73–82) include sample data sets, which are installed in the Data Sets folder.

To locate this folder on the Macintosh: Go to the location on your hard drive where you installed Graph Master. Open the Graph Master folder. The Data Sets folder appears inside.

To locate this folder on Windows: Navigate to C:\Program Folder\TSP\Graph Master.

How do I import a data file from the Internet or a spreadsheet program into Graph Master?

Download the data file from the Internet to your computer's hard drive. Open the file in Graph Master. If the file is unreadable or will not open, follow the directions below.

1. Open the file in Excel or in an AppleWorks spreadsheet. To open correctly in Graph Master, the file must have:
   • column labels at the top of each column
   • no additional text (If your file has extraneous text such as titles and notes, delete the text.)
2. Choose Save As from the File menu.
3. Type a name for your data set file.
4. If you are using Excel, go to the Save File as Type pull-down menu (Macintosh) or the Save as Type pull-down menu (Windows) and choose Text (Tab delimited).
5. If you are using AppleWorks, go to the Save As pull-down menu and choose ASCII Text.
6. Click Save. Open the saved file in Graph Master.
Nine Graph Types

The following pages provide an overview of each of the nine graphs that you can make using Graph Master.

Index

Bar Graph ........................................................................................................................................................................................53
Box Plot ..........................................................................................................................................................................................55
Circle Graph ..................................................................................................................................................................................57
Frequency Chart .......................................................................................................................................................................59
Histogram ..................................................................................................................................................................................61
Line Graph ..................................................................................................................................................................................63
Line Plot ....................................................................................................................................................................................65
Pictograph ..................................................................................................................................................................................67
Scatterplot ..................................................................................................................................................................................69
About the Content

The Nine Graph Types section dedicates two pages to each of the graph types that you can make using Graph Master. For each graph type, we’ve included the following information:

- a definition
- an example of the graph along with a clear explanation of how to interpret it
- sample questions to help students analyze the data
- key terms associated with the graph type
- how to make the graph using Graph Master
- how to make changes to a graph including setting a new scale, changing axis labels, adding a title, and showing statistics

How to Use the Pages

You’ll find many ways to use the Nine Graph Types pages, but to help you get started, we’ve listed a few ideas below.

Make photocopies of these pages and:

- give them to students to introduce or review graph types
- have students record answers to the Questions to Ask Yourself section in their math journals
- create a poster, bulletin board, or data analysis display for your classroom
- incorporate them into a learning or computer center
Bar Graph

A bar graph uses bars to compare categories in a data set. Each bar represents a category. The height of the bar shows the count or measurement of the category.

A double bar graph shows two sets of related data on one graph.

Interpreting Bar Graphs

This bar graph uses bars to compare the popularity of animals in a fourth grade classroom. Each bar represents a different animal. The height of a bar shows how many students preferred that animal. For example, the second bar shows that turtle was the most popular animal.

Questions to Ask Yourself

When you look at a bar graph, ask questions like these:
1. What is this graph about?
2. How many votes did each animal receive?
3. Which animal received the most votes? The fewest votes?
4. How many animals received more than four votes?
5. How many more votes did iguana receive than ferret?
6. How could the information in this graph be helpful?

Key Term

category data  Data that describes or categorizes a group of people or things.
Making a Bar Graph with Graph Master

Once you have entered your data, click Graph on the toolbar. Use two columns of data (or one column, tallied) to make a bar graph. Use three columns to make a double bar graph.

You can make changes to your bar graph by clicking directly on the graph.

Click the graph’s scale to set a new scale.

To change bar colors
1. Choose Change Colors from the Graphs menu.
2. Click a color from the palette. Then click a category to assign the selected color.
3. Click OK to see the changes.

To show or hide grid lines
1. Choose Show Grid from the Graphs menu. (A check mark means grid lines are visible.)

To change the x-axis label orientation
1. Choose Label Orientation from the Graphs menu.
2. Choose Vertical or Horizontal.
Box Plot

A box plot summarizes how numbers in a data set are distributed using five important statistics: minimum, maximum, median, lower quartile, and upper quartile.

Interpreting Box Plots

The box plot below shows the distribution of midterm scores for Mr. Ruiz’s class.

• The lowest test score was 50, and the highest score was 98.
• The median score was 83. This means half the scores were above 83 and half were below.
• The lower quartile (left edge of box) is 78.5. This means that one quarter of the class scored 78.5 or lower on the test.
• The upper quartile (right edge of box) is 89.5. This means that one quarter of the class scored 89.5 or higher on the test.

Questions to Ask Yourself

When you look at a box plot, ask questions like these:
1. What does this box plot show?
2. What is the lowest test score? The highest test score? The median test score?
3. Are scores more spread out above the median or below?

Key Terms

- number data Data that measure or count a group of people or things.
- minimum The smallest value in a data set.
- maximum The greatest value in a data set.
- median The middle value within a data set when the values are placed in numerical order.
- outlier A value in a data set that is much lower or much higher than the other values.
- quartile A number that divides a data set into equal fourths.
Making a Box Plot with *Graph Master*

Once you have entered your data, click Tally on the toolbar. Use one column of number data, tallied, to make a box plot.

You can make changes to your box plot by clicking directly on the graph.

---

**Making Other Changes**

*To mark outliers*

Choose Mark Outliers from the Analyze menu. Outliers are marked with an *.

*To show statistics*

You can display the mean, median, mode, and range for your data. Here's how:

1. Choose Statistics from the Analyze menu, or click the Statistics symbol ( ), to display statistics in numerical format.
2. Click the checkbox located next to a statistic to view a pictorial representation of the statistic on your graph.
Circle Graph

A circle graph is used to compare parts of a data set with the whole. A circle, divided into segments, represents the whole data set. Each segment represents a category in the set. The larger the segment, the greater the count or percentage of the category.

Interpreting Circle Graphs

The circle graphs below show how much money was spent on party supplies. The circle represents the total party budget (in this case, $93.00). Each segment represents a portion of the whole cost. The pizza segment is the largest, which means more money was spent on pizza than on any other item.

The only difference between these two graphs is how they are labeled.
- The labels on the left show that $35 was spent on pizza.
- The labels on the right show that 37.6% of the total party budget was spent on pizza.

Questions to Ask Yourself

When you look at a circle graph, ask questions like these:
1. What is this graph about? (What is the whole? What are the parts?)
2. Which item costs the most? The least?
3. How much more was spent on pizza and cake than paper goods?
4. Which two items make up approximately 1/3 of the total cost?

Key Term

**category data** Data that describes or categorizes a group of people or things.
Making a Circle Graph with Graph Master

Once you have entered your data, click Graph on the toolbar. Use two columns of data (or one column, tallied) to make a circle graph.

You can make changes to your circle graph by clicking directly on the graph.

### Party Costs (in dollars)

<table>
<thead>
<tr>
<th>Item</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>soda</td>
<td>20</td>
</tr>
<tr>
<td>pizza</td>
<td>6</td>
</tr>
<tr>
<td>cake</td>
<td>14</td>
</tr>
<tr>
<td>paper goods</td>
<td>35</td>
</tr>
<tr>
<td>party favors</td>
<td>18</td>
</tr>
<tr>
<td>Total: 93</td>
<td></td>
</tr>
</tbody>
</table>

You can make changes to your circle graph by clicking directly on the graph.

#### Making Other Changes

**To change circle segment colors**

1. Choose Change Colors from the Graphs menu.
2. Click a color from the palette. Then click a category to assign the selected color.
3. Click OK to see the changes.

Click the title of your graph to type a new title.

Click the legend label to type a new label.

Click a circle segment label to change the way segments are labeled (i.e., count, fraction, decimal, percentage, angle measure, no label).
Frequency Chart

A frequency chart displays the frequency (count) of values in a data set. The first column lists each category (or interval of numerical values); the second column shows the number of times the category or interval occurs.

Interpreting Frequency Charts

Twelve students were asked to name the type of transportation they take to school. Their responses are as follows: bus, bike, bus, car, bus, foot, bus, bus, car, bike, foot, car.

A frequency chart can quickly organize the results of this survey to show that bus is the most common form of transportation.

<table>
<thead>
<tr>
<th>School Transportation</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>bus</td>
<td>5</td>
</tr>
<tr>
<td>car</td>
<td>3</td>
</tr>
<tr>
<td>bike</td>
<td>2</td>
</tr>
<tr>
<td>foot</td>
<td>2</td>
</tr>
</tbody>
</table>

A frequency chart can also be used to organize numerical data, such as the list of students’ heights (in inches) as follows: 62, 59, 57, 58, 59, 60, 62, 63, 65, 59, 60, 60, 55, 57, 68.

The chart below shows how many students’ heights fall within different intervals. For example, 6 students are at least 60, but less than 65 inches tall.

<table>
<thead>
<tr>
<th>Student Height</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>55 to 59</td>
<td>7</td>
</tr>
<tr>
<td>60 to 64</td>
<td>6</td>
</tr>
<tr>
<td>65 to 69</td>
<td>2</td>
</tr>
</tbody>
</table>

Questions to Ask Yourself

When you look at a frequency chart, ask questions like these:

1. What does the chart show?
2. How many students are at least 65, but less than 69 inches tall?
3. Which height interval represents the most students? The fewest students?
4. What is the typical height for students in this class?

Key Term

**frequency** The number of times a value occurs in a data set.
Making a Frequency Chart with Graph Master

Once you have entered your data, click Tally on the toolbar. Use one column of data, tallied, to make a frequency chart.

You can make changes to your frequency chart by clicking directly on the chart.

Making Other Changes

To show statistics

You can display the mean, median, mode, and range for your data (number data only). Here's how:

1. Choose Statistics from the Analyze menu, or click the Statistics symbol (Ɇ), to display statistics in numerical format.

<table>
<thead>
<tr>
<th>Height (inches)</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>55 to 59</td>
<td>7</td>
</tr>
<tr>
<td>60 to 64</td>
<td>6</td>
</tr>
<tr>
<td>65 to 69</td>
<td>2</td>
</tr>
</tbody>
</table>
A histogram uses bars to show the distribution of numbers in a data set. Each bar represents a value or interval of values. The height of the bar represents the frequency of values in each interval. Histograms look similar to bar graphs, however numbers, rather than categories, appear along the x-axis, and there are no gaps between bars.

**Interpreting Histograms**

The histograms below show how many points a college basketball player scored during her junior year. The first bar represents games in which she scored 0-4 points. Since the bar is 2 units tall, we can see that there were only 2 games in which she scored less than 5 points. Overall, this player is most likely to score between 15-29 points.

Histograms can be labeled two different ways:

In the first example, the second bar represents integers 5 through 9.
In the second example, the second bar represents numbers that are at least 5, but less than 10.

**Questions to Ask Yourself**

When you look at a histogram, ask questions like these:
1. What is this graph about?
2. In how many games did this player score more than 19 points?
3. Is this player more likely to score over 29 points, or under 10 points?
4. What is the distribution of this data? What does this tell you about this basketball player’s season?

**Key Terms**

- **frequency**: The number of times a value occurs in a data set.
- **distribution**: The way values in a data set are arranged. The values can be spread out evenly or clustered around particular numbers. They can be symmetrical or skewed (more spread out on one side than another).
- **number data**: Data that measures or counts a group of people or things.
Making a Histogram with Graph Master

Once you have entered your data, click Tally on the toolbar. Use one column of number data, tallied, to make a histogram.

You can make changes to your histogram by clicking directly on the graph.

Making Other Changes

You can also use the Graphs menu to show or hide grid lines or to choose whether histogram bars are labeled with numbers centered under bars. Here’s how:

To show or hide grid lines
1. Choose Show Grid from the Graphs menu. (A check mark means grid lines are visible.)

To center number labels under bars
1. Choose Center Numbers Under Bars from the Graphs menu. (A check mark means numbers are centered under bars.)

To show statistics
You can display the mean, median, mode, and range for your data. Here’s how:
1. Choose Statistics from the Analyze menu, or click the Statistics symbol (▶), to display statistics in numerical format.
2. Click the checkbox located next to each statistic to view a pictorial representation of the statistics on your graph.
A line graph uses points connected by lines to show how numerical values change continuously over time. Units of time are displayed along the x-axis; units of value are displayed along the y-axis. Each point shows the value at a particular moment in time.

A double line graph shows two sets of related data on one graph.

Interpreting Line Graphs
This line graph shows how the height of one plant changed over the course of 9 days. The x-axis represents time, measured in days. The y-axis represents height, measured in inches. The points show the plant’s height at a particular moment in time. For example, after 4 days had passed, the plant was approximately 5 inches tall. (Notice that the first measurement was made when the experiment started, after 0 days had passed.)

Questions to Ask Yourself
When you look at a line graph, ask questions like these:
1. What is this graph about?
2. What day showed the largest increase in height? The smallest?
3. What’s the difference between the plant’s height from Day 2 to Day 5?
4. What would you expect the plant’s height to be on Day 10?
5. Describe the overall change in the plant’s height from Day 0 to Day 9.

Key Terms
- **Continuous data**: Data that has no gaps in the range of values. Continuous data usually involves a measurement such as height, weight, or temperature.
- **Number data**: Data that measures or counts a group of people or things.
- **Trend**: A pattern that appears in the data.
Making a Line Graph with Graph Master

Once you have entered your data, click Graph on the toolbar. Use two columns of number data to make a line graph. Use three columns of number data to make a double line graph. In each case, one column of data represents units of time.

You can make changes to your line graph by clicking directly on the graph.

Making Other Changes

To show or hide grid lines
1. Choose Show Grid from the Graphs menu. (A check mark means grid lines are visible.)
A line plot uses columns of identical symbols (usually dots or x’s) to show how values in a data set are distributed. Data values are displayed along a number line. The number of dots above each value shows how many times that value occurs.

### Interpreting Line Plots

A line plot is an easy way to organize data to show frequency. The table below shows students’ weekly allowances. When the data is organized in a line plot, you can quickly see the most common allowance is $10.00. You can also see the outlier, $20.00.

#### Questions to Ask Yourself

When you look at a line plot, ask questions like these:

1. What does the line plot show?
2. What is the most common allowance? The least common allowance?
3. What value is the outlier? What does it mean?
4. What is the range of the data?

#### Key Terms

- **distribution**: The way values in a data set are arranged. The values could be spread out evenly or clustered around particular numbers.
- **clusters**: Clumps of data around particular values.
- **frequency**: The number of times a value occurs in a data set.
- **gaps**: The spaces between clumps of data.
- **number data**: Data that measures or counts a group of people or things.
- **outlier**: A value in a data set that is much higher or lower than other values.
Making a Line Plot with Graph Master

Once you have entered your data, click Tally on the toolbar. Use one column of number data, tallied, to make a line plot. With Graph Master, the range of your data must be 60 or less to make a line plot.

You can make changes to your line plot by clicking directly on the graph.

Making Other Changes

To show statistics

You can display the mean, median, mode, and range for your data (number data only). Here’s how:

1. Choose Statistics from the Analyze menu, or click the Statistics symbol ( ), to display statistics in numerical format.
2. Click the checkbox located next to a statistic to view a pictorial representation of the statistic on your graph.
Pictograph

A pictograph uses columns of identical symbols to compare categories in a data set. Each column represents a category. The number of symbols in the column shows the count of the category. The pictograph legend shows how many units each symbol represents.

Interpreting Pictographs

In the pictograph below, monkey symbols are used to compare the number of monkey species in 5 different zoos. The pictograph legend shows that each symbol represents 10 monkeys. Since there are 3 monkey symbols above Zoo E, and 3\times10=30, this pictograph shows that there are 30 different monkey species in Zoo E.

Questions to Ask Yourself

When you look at a pictograph, ask questions like these:
1. What is this graph about?
2. How many monkey species does each zoo have?
3. Which zoo is home to the most species? The fewest?
4. How many more species does Zoo B have than Zoo D?
5. How could the information on this graph be helpful?

Key Terms

category data Data that describes or categorizes a group of people or things.
legend An explanation of the symbols or information used on a graph.
Making a Pictograph with Graph Master

Once you have entered your data, click Graph on the toolbar. Use two columns of data (or one column, tallied) to make a pictograph.

You can make changes to your pictograph by clicking directly on the graph.

**Making Other Changes**

**To change the symbol**
1. Choose Change Symbol from the Graphs menu.
2. Click a new symbol.
3. Click OK.

**To change the x-axis label orientation**
1. Choose Label Orientation from the Graphs menu.
2. Choose Vertical or Horizontal. (The default orientation is horizontal.)
A scatterplot uses points to show the relationship between paired numerical values. Each point on the graph represents an ordered pair. The first value in each pair is represented by how far a point appears to the right. The second value is represented by the height of the point.

Interpreting Scatterplots
This scatterplot shows the relationship between students’ arm span and height. The x-axis represents height, measured in inches. The y-axis represents arm span, also measured in inches. The shortest student in this class is 56 inches and has an arm span of 57 inches.

Questions to Ask Yourself
When you look at a scatterplot, ask questions like these:
1. What is the shortest arm span? The longest? The arm span of the student who is 70 inches tall?
2. If a new student joined your class and was 65 inches tall, what would you predict about her arm span?
3. Which of the following statements is backed up by this graph:
   • In general, the taller you are, the longer your arm span.
   • In general, the taller you are, the shorter your arm span.
   • Your height doesn’t have any relationship to your arm span.

Key Terms
- paired data  Two sets of numbers in which each value from one set can be paired with a value from the other.
- line of best fit  A straight line drawn on a scatterplot that is as close as possible to all points within a data set. This line helps to show the relationship between the two variables.
- trend  A pattern that appears in the data. A scatterplot can show:
  - a positive trend (as one variable increases, the other increases)
  - a negative trend (as one variable increases, the other decreases)
  - no trend (there is no predictable relationship between the two variables).
Making a Scatterplot with Graph Master

Once you have entered your data, click Graph on the toolbar. Use two columns of number data to make a scatterplot.

You can make changes to your scatterplot by clicking directly on the graph.

Making Other Changes

To show or hide grid lines
1. Choose Show Grid from the Graphs menu. (A check mark means grid lines are visible.)

To show a line of best fit
1. Choose Line of Best Fit from the Analyze menu.

To show statistics
You can display the mean, median, mode, and range for each of the variables in your graph. Here’s how:

1. Choose Statistics from the Analyze menu, or click the Statistics symbol ( ), to display statistics in numerical format.
2. Click the checkbox located next to a statistic to view a pictorial representation of the statistic on your graph.
Classroom Activities

*Graph Master* is a powerful, open-ended tool that helps your students investigate and answer questions across the curriculum by collecting and analyzing data. On the following pages is a set of 20 activities to help you get started. We're sure you'll come up with lots more on your own!

You can use the table of contents below, or refer to the matrix on page 72 for more detail on the graph types, mathematical content, and curricular areas covered by each activity.

Ten of these activities use data that students collect themselves. The other ten use pre-made data set files included with this program. When you install *Graph Master*, these files will be installed in the *Graph Master* application folder, in a folder called Data Sets. (If you are using the network version of the program, the Data Sets folder can also be found on the CD-ROM.)

**Activities with Data Provided**

Allowances .................................................................73
Basketball Statistics ..................................................74
Cities ............................................................................75
Heights ............................................................................76
Immigration & Race ....................................................77
Mean & Median .............................................................78
Olympic Medals ............................................................79
Planets ............................................................................80
Presidents ........................................................................81
Roller Coasters ............................................................82

**Activities Where Students Collect Data**

Coin Toss ........................................................................83
Common Letters ............................................................83
Line Graphs .....................................................................84
Misleading Graphs .........................................................84
Parachutes ....................................................................84
Perimeter & Area ...........................................................85
Pictograph Ratios ...........................................................86
Popular Cars ....................................................................86
Raisins in a Box .............................................................86
A Typical Day .................................................................87
<table>
<thead>
<tr>
<th>Activities with Data Provided:</th>
<th>Page</th>
<th>Bar Graph</th>
<th>Pictograph</th>
<th>Circle Graph</th>
<th>Frequency Chart</th>
<th>Line Graph</th>
<th>Scatterplot</th>
<th>Histogram</th>
<th>Line Plot</th>
<th>Box Plot</th>
<th>Scale &amp; Proportion</th>
<th>Fractions, Decimals, Percentages</th>
<th>Geometry</th>
<th>Probability</th>
<th>Distance, Rate &amp; Time</th>
<th>Shape of Data</th>
<th>Outliers</th>
<th>Trends</th>
<th>Science</th>
<th>Social Studies</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allowances</td>
<td>73</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Basketball Statistics</td>
<td>74</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cities</td>
<td>75</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Heights</td>
<td>76</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Immigration &amp; Race</td>
<td>77</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mean &amp; Median</td>
<td>78</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Olympic Medals</td>
<td>79</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Planets</td>
<td>80</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Presidents</td>
<td>81</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Roller Coasters</td>
<td>82</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Activities Where Students Collect Data:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Coin Toss</td>
<td>83</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Common Letters</td>
<td>83</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Line Graphs</td>
<td>84</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Misleading Graphs</td>
<td>84</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parachutes</td>
<td>84</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Perimeter &amp; Area</td>
<td>85</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pictograph Ratios</td>
<td>86</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Popular Cars</td>
<td>86</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Raisins in a Box</td>
<td>86</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A Typical Day</td>
<td>87</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Activities Matrix
**Allowances**

Have students collect data on the allowance earned by each member of the class (or a sample of students from throughout the school). Collect information on:

- student's grade or age
- student's gender
- weekly allowance
- whether the allowance is contingent on chores (yes, no)
- number of hours spent on chores each week

**Questions students can explore with this data:**

**What does a typical student earn for an allowance?**

Create a histogram of students’ weekly allowances. What is the typical allowance? How do mean, median, mode, and range help to answer this question? If students were making a case with their parents for a particular allowance, how would the data support them?

**Is there a relationship between a student's age and allowance?**

Create a scatterplot comparing age (or grade) and weekly allowance. Is there a relationship? Is the relationship positive or negative? Compare your findings to the data* in the Allowances file. This data was collected from kids all over the country. Regular updates of this data can be found on the Kids’ Money Web site: www.kidsmoney.org/

**Is there a relationship between a student's gender and allowance?**

Create a histogram of students’ weekly allowances. Then clone and filter to create two graphs: one showing the allowances of boys and another showing the allowances of girls. Is there a difference between the two groups? If so, what evidence can you provide?

**Is there a relationship between students' allowances and the number of hours they spend weekly on chores?**

Create a scatterplot comparing weekly allowances and hours spent weekly on chores. Is there a relationship? Is the relationship positive or negative?

* Copyright © 2001 by Kids’ Money. All rights reserved.
Basketball Statistics

The file Shaq’s Stats contains data* on NBA star Shaquille O’Neal’s performance during each game of the 1999–2000 season. Variables include:

- game date
- opponent
- home or away
- win or loss
- total points scored
- field goals made (FGM)
- field goals attempted (FGA)
- free throw percentage (FT%)
- offensive rebounds
- field goal percentage (FG%)
- defensive rebounds
- free throws made (FTM)
- total rebounds
- free throws attempted (FTA)
- minutes played

Questions students can explore with this data:

Is there a home court advantage?
Make a circle graph of the Lakers’ wins and losses during the 1999-2000 season. Clone and filter to create two new graphs: one of wins and losses for home games only, the other for away games only. Compare the two graphs side by side.

How does Shaq’s field goal percentage compare to his free throw percentage?
Create and compare histograms showing Shaq’s field goal percentage (FG%) and free throw percentage (FT%) for the 1999-2000 games. How would you describe the shape of each data set?

How many rebounds does Shaq get in a typical game?
Create line plots of Shaq’s offensive and defensive rebounds. How would you describe the shape of each graph? How are they similar/different? Discuss the mean, median, mode, and range for each graph. How are these measures helpful?

How many free throw attempts does Shaq make in a typical game?
Tally Shaq’s free throw attempts for the season. Display the results as a box plot. Mark the outliers. What circumstances might lead to the unusually high number of free throw attempts? (Students can help answer this question by researching newspaper coverage of the games in question.)

Internet Extensions

Students can find data on other basketball players at NBA.com or WNBA.com.
- Go to: www.nba.com/playerindex.html (NBA)
  www.wnba.com/playerindex.html (WNBA)
- Click on a player’s name
- Click on Game-by-Game Stats (NBA) or Game Log (WNBA)

* Copyright © 2000 by NBA Properties, Inc. All rights reserved.
The NBA and individual NBA member team identifications are trademarks and copyrighted designs, and/or other forms of intellectual property, that are the exclusive property of NBA Properties, Inc. and the respective NBA member teams and may not be used, in whole or in part, without the prior written consent of NBA Properties, Inc.
Cities

The file Cities contains data* on the population of eight U.S. cities during each decade from 1800 to 1990. Cities include:

- Boston
- New York
- Los Angeles
- San Francisco
- Detroit
- Chicago
- Savannah
- Atlanta

Questions students can explore with this data:

How did the population of New York (or any other city) change over time?

Create a line graph showing how the population of a city changed between 1800 and 1990. When did the city’s population grow most rapidly? Least rapidly? Have students research the historical factors that influenced the city’s growth. Based on trends in the data, what would you expect the population to be in the year 2000? (Students can do research to test their predictions.)

How does population growth in Savannah and Atlanta (or any other two cities) compare?

Create a double line graph showing the population growth in Savannah and Atlanta between 1800 and 1990. How would you compare the growth of these two cities? Research the historical reasons behind the trends you observe.

Internet Extensions

Additional population data can be found on the U.S. Census Bureau Web site:
www.census.gov

* Data provided courtesy of the U.S. Census Bureau.
Heights

The file Heights contains data on students in 4th, 6th, 8th, and 12th grades (collected from several different schools). Variables include:

- grade
- height
- gender

Questions students can explore with this data:

How tall are students in each grade?
Create a histogram showing the heights of all students. Filter the graph to show the heights of students in one grade only. How would you describe the data? Show statistics. How do the mean, median, mode, and range help summarize this data? Repeat for other grades.

Is there a grade when girls are typically taller than boys?
Clone the graph that you made in the activity above two times. Filter the first cloned graph to display data for boys in the fourth grade only. Filter the second cloned graph to display data for girls in the fourth grade only. Compare these graphs side by side. Display statistics for both graphs. How do the mean, median, mode, and range help you compare the heights of fourth grade boys and girls? Repeat for grades 6, 8, and 12. In which grades are boys taller than girls? In which grades are girls taller than boys?

What is the relationship between a student’s grade and height?
Create a scatterplot showing the relationship between a student’s grade and height. Display a line of best fit. Is there a clear relationship between grade and height? If so, is it a positive or negative relationship?
**Immigration & Race**

The file States contains data on the population of 48 U.S. states in the year 1930. Variables include:

- state
- total population (age 10 and up)
- native white population (age 10 and up)
- foreign white population (age 10 and up)
- black population (age 10 and up)
- other population (age 10 and up)

**Questions students can explore with this data:**

**Which states have the largest foreign white population?**

Sort the data table by column D (Foreign White Population) in descending order. Create a chart showing which states have the highest foreign white population. Using the formula feature, calculate the percentage of each state's total population that is white and foreign-born (% Foreign White) and create a chart of this data. In what ways is this presentation of the data more meaningful? (Percentages allow you to make valid comparisons between states with differing populations.) Discuss historical reasons why some states have a higher percentage of foreign-born white people than others.

**Which regions have the largest foreign white population?**

Create a new column in the data table called Region. Assign each state to a region of the country (Northeast, Midwest, South, West, etc.). Create a histogram from the % Foreign White column. Clone and filter this histogram to compare different regions of the country.

**Which states/regions have the greatest percentage of blacks? Of native-born whites? Of people whose race was listed as neither black nor white?**

Repeat the above explorations for data on native white, black, and other segments of the population.

**Internet Extensions**

Students can find more population data at the following Web sites:

- United States Historical Census Data Browser: fisher.lib.virginia.edu/census/
- U.S. Census Bureau: www.census.gov

* Copyright © 2001 Inter-university Consortium for Political and Social Research (ICPSR). All rights reserved.
Mean & Median

The file Centers contains data showing how many siblings each of 5 classmates has. A data table appears on the top left, a line plot (with mean and median displayed) below. When students change the data, the line plot (and its mean and median) change dynamically. Have students explore measures of center by constructing data sets that meet the following criteria:

• There are 5 students in the class.
  The students’ mean number of siblings is 3.

• There are 5 students in the class.
  The students’ mean number of siblings is 3.
  None of the 5 students has exactly 3 siblings.

• There are 5 students in the class.
  The students’ mean number of siblings is 3.
  One of the students has 12 siblings.

• There are 6 students in the class. (A new student has joined.)
  The students’ mean number of siblings is 3.

• There are 6 students in the class.
  The students’ mean number of siblings is 3.
  The median number of siblings is 2.

• There are 6 students in the class.
  The mean number of siblings is less than the median.
**Olympic Medals**

The file Olympics contains data* on the number of medals won by each participating country in the 2000 Olympics. Variables include:

- country
- number of gold medals won
- number of silver medals won
- number of bronze medals won
- total number of medals won

**Questions students can explore with this data:**

**Which country won the most medals overall? Which country won the most gold, silver, bronze?**

Create a frequency chart showing the number of medals won by each country. To see countries in order of the number of medals won, sort the data table by column E (Total Medals), in descending order.

**How were medals distributed in the 2000 Olympics?**

Create a histogram of the number of medals won by different countries. What does this distribution show? Are medals distributed evenly, or do a few countries win the majority of the medals? View the histogram described above with statistics displayed.

**How many medals does a typical country win?**

Which measure of center (mean, median, or mode) gives the best picture of the number of medals a typical country wins? View the data as a box plot and mark outliers. How do outliers affect the mean?

**Which region of the world won the most medals?**

Create a 6th column labeled “Region,” and list a continent or region for each country. Create a histogram of medals won (as described above) and then filter by region to see if certain regions/continents won more medals than others.

Planets

The file Planets contains data* on each of the nine planets in our solar system. Variables include:

- planet
- distance from the sun
  - 1 unit = distance of earth from sun (93,000,000 miles or 150,000,000 km)
- orbit period (in years)
- diameter (measured at planet’s equator, where diameter is largest)
  - 1 unit = diameter of earth (7928 miles or 12,756 km)
- volume
  - 1 unit = volume of earth
- planet solar day (in days)
  - This is the period between noons (the time when the Sun is halfway across the sky).
- planet spin (in days)
  - This is the period to complete one physical rotation relative to the rest of the universe - not the same as a solar day. When the spin is slow compared to the orbit period, planet spin and solar day are very different, because the planet moves a significant distance along its orbit in the time to complete one spin.
- weight (per 100 lbs on earth)
  - This is what you would weigh (at the surface of each planet) if you weighed 100 lbs on earth. On the giant planets, which have no solid surface, you would have to weigh yourself on a platform hovering at some “surface level,” suspended by a balloon.
- average temperature from space (in Kelvins)
  - The Kelvin scale counts from absolute zero in Celsius degrees. The melting point of water is 273 Kelvins.
- average temperature from space (in degrees Fahrenheit)
- average surface temperature (in Kelvins)
  - For the giant planets, which have no solid surface, “surface” means the level in the atmosphere where the pressure is the same as at earth’s surface. The same level is used for the weight data.
- average surface temperature (in degrees Fahrenheit)
- number of satellites
- number of rings

Questions students can explore with this data:

How do the other planets compare to earth?

Create graphs of different characteristics, such as distance from the sun, or number of satellites. Which graph type best represents each set of data? How do the other planets compare with earth?

Is there a relationship between a planet’s distance from the sun and its temperature? number of rings? orbit period? between volume and weight (per 100 lbs)?

Create scatterplots exploring the relationship of various planetary characteristics. Do some reveal strong relationships? How can these relationships be explained?

How do planets’ temperatures vary when measured on the surface vs. from space?

Create a double bar graph displaying the surface temperature and temperature from space for each planet. For which planets are these two measurements similar? For which are they very different? Have students investigate and discuss the reasons for these differences.

Presidents
The file Presidents contains data* on each of the presidents of the United States. Variables include:

• number (1st, 2nd, etc.)
• name
• political party
• term start (year)

• term end (year)
• term length (in years)
• died in office (yes or no)
• religion

• age at inauguration (in years)
• age at death (in years)
• state of residence

Questions students can explore with this data:
How many presidents have we had from each political party?
Create a bar or circle graph of presidents’ political parties. Which party was most represented? Encourage students to research the history of each party. (Did the parties stand for the same issues and ideals at different points in history?) Clone and filter the graph to compare the proportion of presidents in each political party at different points in time (e.g., pre-1865, 1865 and after).

How well do our presidents reflect the religious diversity of the United States?
Create a bar or circle graph showing the religions of the presidents. Which religions are most common? Which are not represented at all? Clone and filter the graph to compare the proportion of presidents of different religions at different points in time (e.g., pre-1900, 1900 and after). Have students investigate the frequency of different religions in the general population.

What is the typical term length of a U.S. president?
Create a histogram of presidents’ term lengths. Discuss the appropriate intervals for this graph. (Is it helpful to use intervals of 2 rather than 4? Why or why not?) What was the shortest presidential term? The longest? What’s the story behind these? Have students research the 22nd Amendment to the Constitution, ratified in 1951, which limited presidents to two terms in office.

How old are presidents, typically, when they take office?
Create a histogram of presidents’ ages when first taking office. What is the typical age when presidents take office? How do statistics such as mean, median, mode, and range help answer this question? What is the youngest legal age for a president? (35)

Roller Coasters

The file Coasters contains data on roller coasters at each of the Six Flags Theme Parks located in the United States. Variables include:

• coaster name
• coaster type
• park
• location
• material (metal or wooden)
• date opened
• height (in feet)
• height of first drop (in feet)
• maximum speed (in miles per hour)
• track length (in feet)
• passengers per car
• ride time (in seconds)

Questions students can explore with this data:

How tall are Six Flags roller coasters?
Create a histogram showing the heights of all Six Flags roller coasters. How would you describe the data? Show statistics. What does each measure (mean, median, mode and range) tell you about the data?

How do wooden coasters compare with metal coasters?
Create histograms of various coaster attributes (such as height or speed). Then filter your graphs to display data for wooden coasters only or metal coasters only. Which type of coaster is typically faster, taller, longer? Display statistics and discuss how the mean, median, mode, and range help you compare these two groups of coasters.

What is the relationship of a coaster's height and its speed?
Create a scatterplot showing the relationship between the height of a coaster and its speed. Is this a clear relationship? If so, is it a positive or negative relationship?

Maximum speed vs. average speed
Use the formula feature to calculate the average speed (in mph) of each coaster using the information on track length and ride time. (Students will need to convert units.) Compare this to the maximum speed. Is there a relationship?

Internet Extensions

Students can find more roller coaster data at the following Web sites:
• Six Flags Theme Parks: www.sixflags.com
• CoasterBuzz: www.coasterbuzz.com
**Coin Toss**

*What is the probability of two coins landing on tails in the same toss?*

Divide your class into teams of two. Provide each team with two coins and ask them to predict the outcome of a two-coin toss after fifty tosses. Record their predictions.

Instruct students to toss the coins fifty times and record the outcome of each toss (i.e., HT for head/tail, HH for head/head, and TT for tail/tail). Enter each team’s data into separate columns in the data table. Make circle graphs comparing data sets from different teams. What do students notice about the percentage of head/tail outcomes in comparison to tail/tail outcomes? If you were to flip the coins 100 times what do you predict the outcome to be?

**Internet Extensions**

Students may want to explore the following coin flipping Web site: shazam.econ.ubc.ca/flip/index.html.

**Common Letters**

*Which letters of the alphabet are most frequently used in the English language?*

Students work in pairs to tally the number of times different letters in the alphabet appear on a page of literature. At the computer, they enter the data in the data table and make a frequency chart that shows the frequency of each letter.

As an extension, students enter the assigned value of each letter in the board game Scrabble into a new column in the data table. They create a scatterplot comparing the total number of times each letter appears and the value in Scrabble. Is there a relationship between the data? Is there a positive, negative, or no correlation?
Line Graphs
When should you use a line graph?

Have students record the temperature outside each hour for ten consecutive hours in a given day. Create a line graph of the data. Pose questions such as: What do the points represent? What do the lines represent? Can you use this graph to estimate the temperature between measurements? Why is a line graph appropriate to use with this type of data?

Now make a line graph showing class attendance for one week. What do the points represent in this graph? Do the lines connecting points have meaning? (No, because it does not make sense to give the attendance of a class on day 1.5.) Does a line graph make sense for this data? (No, because the data is discrete.)

Discuss the differences between discrete and continuous data.

Misleading Graphs
How can a graph misrepresent data?

The data in graphs is not always shown correctly. Sometimes the data is shown inaccurately or is intentionally misrepresented. Gather two or three examples of misleading graphs from newspapers, magazines, or the Internet. Make transparencies of these graphs and have students examine them. Ask students to identify why these graphs are misleading (e.g., the scale does not start at zero, the spaces between intervals are uneven, the graph is not titled appropriately, etc.) and who would benefit from the misrepresented data.

Now divide students into teams. Allow time for each team to collect graphs from the resources mentioned above. At the computer, instruct the teams to create graphs from their data to support different points of view. Finally, compare the graphs side by side. Have the students examine the scales, axes labels, titles, and other features that result in a misleading graph.

Parachutes
Is there a relationship between the size of a parachute and its rate of descent?

Have students brainstorm everything they know about parachutes and how they work.

Divide the class into teams of four. Provide each team with a small garbage bag, string, paper clips, and a walnut. Instruct each team to create a parachute out of the materials provided, with the goal of creating the parachute that descends the most slowly. Designs may vary in a number of ways including size (perimeter or area of the parachute), shape, and weight (paper clips vs. a walnut).

Students test their parachutes by dropping them from a fixed height (e.g., 10 feet) and measuring the time it takes for the parachute to drop to the floor (hang time).

Enter the following information for each parachute into the data table: area, perimeter, weight (in grams), height of drop, and hang time. With the formula feature, calculate the rate of descent for each parachute using the formula d=rt.
After the rate of descent is calculated, have students create graphs showing the rate of descent for their parachutes. They can use the filter feature to view the results for different types of designs (large vs. small parachutes, parachutes with or without paper clips attached, etc.) By creating a scatterplot, students can also explore the relationship between the hang time and the rate of descent.

Perimeter & Area

How are perimeter and area related? If you have a fixed amount of fence, what shape encloses the largest area?

Present students with the following problem: You want to create an enclosed rectangular pen for some animals, and you have exactly 40 feet of fence. What different types of rectangles can you make? Which shape encloses the largest area? Have students make conjectures.

Have students work in groups, and come up with examples of different size pens that could be made with 40 feet of fence. Enter each example in the data table. Include length, width, and area. (You can use the formula feature to calculate the area.) Create scatterplots from this data showing the relationship between length and area, and between width and area. What can you conclude from these graphs? (Students can create additional data sets exploring the same problem with a different perimeter. Does the same pattern seem to hold?)
Pictograph Ratios

What information do you need in order to assign a value to a pictograph symbol?

Show students examples of pictographs. For each graph, ask questions such as: What is the value of each pictograph symbol? How would the pictograph change if the value of the symbol increases? If the value decreases?

Have students collect data about their classmates, school, or community. At the computer, enter the data into the data table and create a pictograph. Explore changing the value of the pictograph symbol based on students’ suggestions. Ask questions such as: How many symbols will you get in the largest category if each symbol represents 5 people? 10 people? What is the best symbol value for the data? Why?

As an extension, print examples of the class’ pictographs with different symbol values. Photocopy the graphs and randomly distribute them. Ask students to write an explanation about whether or not the best symbol value has been assigned.

Popular Cars

What is the most popular make of car at our school?

Take students outside to the parking lot and conduct a survey of cars. Have them record the make of each car, the color, and whether it is a two-door, four-door, or SUV. At the computer, have students work in pairs to enter the following data in the data table: car make, color, type (two-door, four-door, or SUV). Instruct each pair to tally the car make column and to create a circle graph labeled with fractions. Clone the graph and change the circle graph labels to decimals. Compare both graphs side by side. Challenge students to predict the angle measurement for each segment.

Now use the filter feature to show only the four-door cars or only the green cars in the parking lot. Print out the graph with no labels. Have students label the graph with angle measurements or fraction estimates.

Raisins in a Box

Do boxes of raisins contain an equal amount?

Provide each student with a small box of raisins and ask them to predict how many are in the box. Record their predictions. Have students count the actual number of raisins in their box. Enter the data into the data table. Tally the data and create a line plot. Show statistics. How do the mean, median, mode, and range help summarize this data?

Now clone the line plot. Click the Box Plot graph type button on the cloned graph. Show statistics. Compare the two graphs. Arrange the graphs on screen so that the line plot takes up the top half and the box plot takes up the bottom half. How do these graphs relate to one another?
A Typical Day

How do students spend their time during a typical day?

Have students record how they spend their time in a 24-hour period. For younger students, you may want to brainstorm categories as a class such as school, eating, sleeping, reading, sports, homework, television, etc.

Enter the data in the data table and create a variety of graphs to explore questions such as:

• How many hours per day do students spend doing homework? Watching television? Playing sports?
• Is there a relationship between the number of hours a student spends watching television and the number of hours spent on homework?
• Which activity shows the greatest range of values? The least?
• Overall, how would you describe the typical day of a student? How do measures of center (mean, median, mode) and spread (range) help answer this question?
# Math Curriculum Matrix

The curriculum matrix below shows how Tom Snyder Productions products address a range of math curriculum objectives.

<table>
<thead>
<tr>
<th>Number &amp; Operations</th>
<th>Data Analysis &amp; Probability</th>
<th>Geometry</th>
<th>Measurement</th>
<th>Algebra</th>
<th>Problem Solving</th>
<th>Communication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Whole Number Operations</td>
<td>Fractions &amp; Decimals</td>
<td>Ratios &amp; Percentages</td>
<td>Denominations &amp; Place Values</td>
<td>Estimation</td>
<td>Graphs &amp; Charts &amp; Analysis</td>
<td>Data Collection &amp; Analysis</td>
</tr>
<tr>
<td>The Graph Club</td>
<td>K-4</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Neighborhood MapMachine</td>
<td>1-5</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Community Construction Kit</td>
<td>1-5</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Classroom StoreWorks</td>
<td>2-6</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Fizz &amp; Martina’s Math Adventures</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Buddies for Life</td>
<td>1-2</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>• Caves of Blue Falls</td>
<td>2-3</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>• Blue Falls Elementary</td>
<td>3-4</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>• Project Sphinx</td>
<td>4-5</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>• Lights, Camera, Fractions!</td>
<td>5-6</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Science Court: Statistics</td>
<td>4-6</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>PrimeTime Math</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Adrift!</td>
<td>4-5</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>• Lost!</td>
<td>5-6</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>• Cliffbound!</td>
<td>6-7</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>• Stakeout!</td>
<td>6-7</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>• Emergency!</td>
<td>7-8</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>• Fire!</td>
<td>8-9</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Math Mysteries</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Whole Numbers</td>
<td>4-5</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>• Advanced Whole Numbers</td>
<td>4-5</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>• Fractions</td>
<td>5-6</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>• Advanced Fractions</td>
<td>6-7</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>• Measurement</td>
<td>4-5</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Tessellation Exploration</td>
<td>4-8</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Graph Master</td>
<td>4-8</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
</tbody>
</table>
Index

Activities 71–87
Analyze menu 45–47
Axis labels 13, 16, 44

Bar graph
  Interpreting 53
  Making 54
BMP, Save As… 44
Box plot
  Interpreting 55
  Making 56

Category data vs. number data 30
Cells 12, 29
Center Number Under Bars 43
Change Circle Graph Labels… 44
Change Colors… 42
Change Intervals… 40
Change Pictograph Scale… 41
Change Pictograph Symbol… 42
Change Scale… 40
Chart  See Frequency Chart
Choose Graph Type 32
Choose Independent Variable 32
Choose Variables 31
Circle graph
  Interpreting 57
  Making 58
Clear 37
Clone Graph 44
Close Data Set 35
Close Window 35
Column
  Hiding/showing 40
  Labels 29
  Letters 29
  Selecting 29
  Compare 45
Copy
  Graph 37
  Text 37
Create Graphs  See Graphs
Cut 37

Data
  Copying 37

Entering/deleting 30
Graphing 31–33
Importing from Internet/spreadsheet 50
Number vs. category 30
Tallying 22–23, 34
Data menu 11–40
Data Table
  Button 34
  Entering data 30
  Navigation within 30
Delete Graph 44
Double bar graph 53–54
Double line graph 63–64

Edit Graphs  See Graph, Changing
Edit menu 37
Edit mode 30
Exit 36

File menu 35–36
Filter 45
Formula 39
Frequency chart
  Interpreting 59
  Making 60
Glossary 48
Graph
  Button 34
  Changing 16–17, 33
  Cloning 44
  Creating 31
  Deleting 44
Graph Types 36
  Bar graph 53
  Box plot 55
  Circle graph 57
  Frequency chart 59
  Hiding/Showing 44
  Histogram 61
  Line graph 63
  Line plot 65
  Pictograph 67
  Scatterplot 69
  Viewing 34
Graphics programs 37, 43–44
Unavailable graphs 15
Undo 37
Upper quartile 55

Variable 14

Web site 48
Window List 34
Write in notebook 19, 34